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From the Editor:

January’s deep freeze is coming to an end and that should encourage all of us to attend a meeting. Fortunately
February has an abundance available. The Annual Meeting will be on Saturday. March 2nd. See Below.

Please note, until further notice, the Q&A SIG will meet on the second Monday of each month.

Tom Ostertag, Publications Director

Meeting Calendar

This information was compiled as Meeting Calendar — February 2013
this newsletter was bs:ing Tuesday February 5 | 7:00 pm Mac OSX SIG
assembled and is subject to Monday February 11 | 6:30 pm Mac Q&A SIG
change. As always, confirm the
Special Interest Group (SIG) date, Wednesday | February 13 | 7:00 pm VectorWorks SIG*
time, and location with the SIG Wednesday | February 13 | 7:00 pm | TC Photoshop User Group*
Leader or the mini’app’les Tuesday February 19 | 7:00 pm 10S SIG
website: www.miniapples.org. Thursday February 21 | 7:00 am Mac Consultants SIG
Thursday February 28 | 6:30 pm FileMaker Pro SIG
Saturday March 2 1:00 pm Annual Meeting
Meeting Locations and Leaders
Meeting Location Leader
Mac OSX SIG Ridgedale Library, 12601 Ridgedale Dr., Bob Demeules, 763-559-1124
Minnetonka, 55305
Mac Q&A SIG Wentworth Library; 199 East Wentworth Ave, Harry Lienke,
West St. Paul gasig(@miniapples.org
VectorWorks SIG* CJR Office, 4441 Claremore Dr., Edina Charles Radloff, 952-941-1667
TC Photoshop User | Mpls College of Art & Design, 2501 Stevens Ave. | Jeff Tranberry
Group* So, Minneapolis
10S SIG Hack Factory, 3119 E. 26th Street, Minneapolis | Tim Drenk, 952-479-0891
Mac Consultants SIG | Good Day Cafe, 5410 Wayzata Blvd., Golden Bob Demeules, 763-559-1124
Valley
FileMaker Pro SIG Erik’s Bike Shop Corporate, 9201 Penn Ave S. #1, | Steve Wilmes, 651-458-1513
Bloomington
Annual Meeting Friendship Village, 8100 Highwood Dr, Tim Drenk, 952-479-0891
Bloomington, MN
* This SIG is NOT sponsored by mini’app’les; the listing is provided as a service to members.
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Annual Meeting at Friendship Village Q&A SIG Meeting * 14 January 2013

by Jeff Berg by Harry Lienke

I am pleased to announce that the mini'app'les On January 14, 2013, our small ,

Annual Meeting will take place from 1-4 pm on but bold and hardy band of Dy m‘\

Saturday, March 2, 2013. The meeting will be held Macintosh warriors ‘ [ / :

in the Community Room at: known as the Question and ‘;2 'Z/ .\:\‘(e {E \

Friendship Village Answer Special Interest i 1‘:\; |

$100 Highwood Dr. Group (Q&A SIG) ventured % \é‘g

Bloomington, MN to the Far East and met at i
Woodbury’s TEAM

The agenda for the meeting will include: Technology store. Our hosts,

* Guest Speaker, Patrick Rhone Dave Schroeder and John O’Brien-Schroeder,

» Officers Reports provided a comfortable computer-data-sharing

* Nomination of New Officers environment as well as lots of pertinent information.

» General Q&A/Discussion as time allows

+ Short Board of Director’s Meeting following For our visual information we used the large display

screen TEAM Technology uses for the courses they
teach on-site. Since Mac OS X 10.8 is needed to
mirror a Mac’s display via AirPlay, I updated my
Fall in love with your Macintosh MacBook Pro (MBP) to 10.8 and, so I could test my

. ' set-up, purchased an Apple TV with an HDMI cable.
I was quite surprised and very pleased when I was
able to stream information from the computer to the
screen of my home TV. When we tried mirroring my
MBP with the TEAM equipment, everything worked
perfectly there, too. The Apple TV could not have
made things simpler.

N
<
o
<
i
N
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2
S

When I mentioned problems we were having at
_ home video-chatting between computers, Dave
System 7.5 introduced me to FaceTime. We set up a video
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conference between my MBP and a demonstration
MBP. One of the meeting attendees mentioned using
FaceTime and planned to use it for communication
when traveling.

When I updated my computers to Mac OS X 10.8, 1
went to some extra effort to align user identifiers
(IDs) between the computers (if you don’t create
user accounts in the same order on different
computers, you end up with conflicting IDs causing
disk permission difficulties when you transfer data
between computers). To start the 10.8 installation, I
erased the internal drives and then used Migration
Assistant to move applications and data; Migration
Assistant moved the incorrect permissions so I ended
up transferring apps and data manually. One of the
attendees and John mentioned incidents using
Migration Assistant and having it transfer most data
from one hard disk to another but failing to transfer
one entire folder of data. The lesson here is to check
carefully that all data has been transferred before
modifying any source data.

I mentioned the difficulties we are having
transferring calendar and contact data from OS X
10.6.8 to 10.8.2 via 10.7.4. There were many
calendars with identical names that showed up in
10.7 and required sifting through the data to find and
keep all information. Dave pointed out that if I had
exported the information, all information would have
been combined automatically, making the sifting
through data unnecessary. Similarly, troubles
transferring Contact data due to iCloud capturing
data and combining it with older data can be
overcome if an archive is established, all data on a
Mac and in iCloud being deleted, and then the
Contact data re-established from the archive.

A question was asked about a utility to allow
multiple libraries to be used with iPhoto. iPhoto
Library Manager was mentioned; it costs $30. iPhoto
Buddy is a free utility that allows multiple libraries
but does not include the other bells and whistles that
iPhoto Library Manager has.

The mini’app’les Annual Meeting is coming up on
Saturday, March 2. It is being held at Friendship
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Village (8100 Highwood Drive, Bloomington) this
year. More details to follow.

John demonstrated the OS X capability to magnify a
section of the screen. Select System Preferences >
Accessibility > Zoom and enable “Use keyboard
shortcuts to zoom.” Options are available to zoom
the whole screen or see a picture-in-picture; the
picture-in-picture size can be adjusted.

A question about Mail behavior was emailed prior to
the meeting. An email was sent with an incorrect
address and now multiple error messages are being
received. Since the questioner was not at the
meeting, the circumstances under which the error
messages were received were subject to conjecture.
Two points of view were expressed. Apple’s Mail
program may be offering the incorrect address and
need to have the incorrect address deleted (Mail >
Window > Previous Recipients). A second
possibility is that the mail server is simply making
several attempts to deliver the misaddressed email
and will give up shortly and send no further error
messages.

There was some discussion about Junk Mailboxes
appearing in Mail’s left-hand column (Junk
Mailboxes appear when a Filter classifies email as
junk) and being emptied (behavior of the Junk
Mailbox is set via Mail > Accounts > account name
> Junk).

Updating Quicken databases and the current state of
the Quicken software was discussed quickly.

The next meeting will be at the Wentworth Library
(199 Wentworth Avenue East) in West St. Paul on
February 11. We will be using the small meeting
room near the back of the library. Our meeting will
start at 6:30 pm and last until about 8:15 pm. PieSIG
will be held at the Bakers Square Restaurant on
South Robert Street one long block south of Marie
Avenue.

“FALL IN LOVE WITH YOUR MACINTOSH
ALL OVER AGAIN!”
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iOS SIG Meeting Report * 15 January 2013
By Tim Drenk

This month we looked at Pocket Informant Pro
(http://pocketinformant.com/) which provides
calendar and task management for iPhones and
iPads. It currently is $15, although the company does
have frequent sales. There is also Pocket Informant
Go which is $5 and has fewer features, but we
focused on the Pro version. Here a few of the
features we covered:

Calendar Details: G
Pocket Informant

@ @ 100% >

has multiple November
. Sun Mon Tue Wed
views, Year, 3 81 1Nov
'zm' 1p Test
Month’ Week’ 45\ 10:30a W e 2d
Day, List, and a
Today view. N o= S
Swiping left or 458 Mo We Were -
right will move
. 11 15 16 17
from one view to
the next. Events i
can be added 18 19) + 20 21 22 23 24
easily in any of e (i e
. . 1p E- ped | 10:45a S- 6:30p Tae
the views with a e
few taps. PI 25 2 27 28 29 30  [1Dec
p
9:45a Mo G 7o Wedn 1 Jaso
supports templates = 10308 W
which allows for 7 Check
creating frequently G EEN'o EERVIL, V4

OCCU.I’I'll’lg eVel’ltS Today Calendar Tasks Contacts Notes
with specific

details such as alarms, tags, icons, notes. Location
mapping, multiple alarms, and adding photos are
supported for individual events.

Task Details: PI will adjust settings depending on
your task style, simple, standard, Franklin Covey, or
GTD Tasks. Tasks can be grouped, have sub tasks
and tags, and are location aware.

Contact Details: PI can fully access the contacts on
the device (provide you allow it to so). You can
make a call directly from the contact without leaving
PI. In landscape mode, PI will scroll through
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contacts by photo.
A swipe on a
contact will create
an event or task or
an email.

Notes Details:
Notes can be text
notes or recorded voice

notes. Notes can be filtered which makes searching
very easy.

Syncing Details: Calendar events can be synced
through 1Cloud
because PI simply
accesses the built-
~  in calendar
database.
Reminders can
also be synced.
Tasks are not
synced through
iCloud, however,
PI does sync with

wi__Verizon & 5:25 PM @ O 81% EAD

All Active

Chris and Alex List
Al @ Chris and Alex List

Investigate Package Tracking Ul

Al @ Chris and Alex List

Soundbar/speaker exchange?...

Al @ Chris and Alex List

Reminders

Check the pay visa task in... a
L 11/4/12, 9:00 PM (15...

Pay Mastercard ma

\ 11/10/12, 2:00 PM (9...

- Google Calendar
and Tasks and
~ Toodledo for

Call Verizon to add Thomas to...

& tasks. WeblIS also
Reminders on Phone has a feature

FcC called Pocket
— Informant Online

3 0 Al @ . .
© M " (Ml which provides
Today Calendar Tasks Contacts Notes
the most complete

sync and can be accessed online. Currently Pocket
Informant Online is $15 per year.

The next 10S SIG meeting is February 19th, (the
third Tuesday of the month) at the HackFactory at
7:00 P.M. We will be comparing a number of apps
that can view and annotate PDFs such as
GoodReader, PDFExpert, and DocsToGo.

ATTEND A MEETING IN FEBRUARY
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Do You Need Mac Antivirus Software in
20137

by Rich Mogull

It has been over four years since [ wrote “Should
Mac Users Run Antivirus Software?” (18 March
2008). Although much has changed since then, my
recommendations mostly haven’t. While Macs aren’t
immune to malicious software (malware), and we
even experienced one reasonably widespread
incident in 2012, malware on Macs is still not nearly
common enough to recommend antivirus software
for everyone. And while antivirus tools are effective
against certain known attacks, they often don’t
provide the level of protection people expect.

More Malware, but Still Rare -- In April 2012, we
experienced Flashback, the first real, widespread
malware attack against Macs (see “How to Detect
and Protect Against Updated Flashback Malware,” 5
April 2012). By some accounts over 500,000 Macs
were infected at one point, but there is no evidence
that any infected Macs or Mac users were actually
harmed in the attack. This quickly led to predictions
in certain corners that the Apple “age of innocence”
had come to an end, and Mac users would now face
as many and as severe malware attacks as Windows
users.

Since that fateful week we have seen not a single
additional widespread attack, and only a handful of
smaller pockets of infection similar to the pre-
Flashback days. (Note that there were some attacks
against specific targets, but antivirus is relatively
ineffective at stopping these.) Despite those
predictions, Mac users haven’t seen any significant
increases in malware, and it is still quite rare.

Some of this is due to steps Apple took both before
and in response to Flashback, which I outlined in
“Examining Apple’s Security Efforts in 2012 (20
December 2012). Gatekeeper was designed to reduce
the likelihood of a user being tricked into installing
malware on their own computer — still the most
common attack against Macs (see “Gatekeeper

Slams the Door on Mac Malware Epidemics,” 16
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February 2012). Apple continues to harden the
operating system itself, making it more difficult (but
far from impossible) to exploit remotely. All apps in
the Mac App Store must now implement
sandboxing, which reduces the harm they can cause
if they are compromised — although,
embarrassingly, Apple has yet to sandbox its own
apps. And Apple significantly changed how Java and
Adobe Flash, the software exploited by Flashback,
are supported and enabled to further restrict their use
as a vector for infection via a Web browser.

Plus, if reports are accurate, Flashback failed to net
any significant profits for the attackers. For the most
part, bad guys are in it for the money, and they drop
unprofitable product lines like any other business. In
fact, Apple’s security changes have, by its own
admission, focused more on disrupting the
economics of malware than trying to stop any single
vector of attack.

This doesn’t mean there won’t be successful attacks
against Macs, but all signs point to those attacks
being limited — occasional one-off incidents rather
than the constant maelstrom of endless attacks we
have seen against Windows. The ecosystem —
thanks to its size and Apple’s protections — simply
can’t support ongoing waves of Mac malware. Even
the latest versions of Windows don’t face the same
malware issues as earlier efforts.

Some of these future incidents will be widespread,
but they will also very likely be discovered and
contained quickly. As for antivirus, the odds are
against the tools playing a significant role in
preventing these attacks due to their inherent
limitations.

The Limits of Antivirus -- There are two main ways
to detect malicious software: detect unusual activity,
or recognize something in the software that marks it
as malicious. Nearly all antivirus tools on the market
rely mostly or exclusively on “signatures” for
malware detection.

A signature is typically a string of text, often a hash
value of a portion of a known piece of malware.
Antivirus companies scour the Internet looking for
malware samples. Once they find a malicious
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program, they create a signature based on the
application’s code, then push this signature into the
antivirus software on your computer when you
update your virus definitions. Your antivirus
software scans new files as they come into your
computer, plus all files on your system periodically,
looking for these signatures.

Security tools tend to avoid relying on behavioral
analysis because it is very hard to know whether any
particular action on a general purpose computer is
“bad.” For any malicious action you can think of,
odds are there is a legitimate reason for that activity
in a different context. It is also difficult to hook into
an operating system at the right level to capture this
activity. And unless you detect and manage to
prevent the act of infection (which may look exactly
like normal software installation), the malware gets
to run on your system before the tool has an
opportunity to detect bad activity. Behavioral
analysis is thus fairly limited, and more effective in
controlled environments, such as enterprise servers,
than on personal computers.

The advantage of signature scanning is that if there
is a match, and the signature is well-crafted, you
have positively identified a known piece of
malicious software. You can also scan software
before it ends up on your system or runs in the first
place. But there are two very large downsides.

The most obvious limitation is that to create a
signature, the antivirus vendor needs a sample of the
malware. They can build signatures only for what
they find, meaning new malware always has some
running time before the first sample is collected,
turned into a signature, and pushed down to client
computers. Not every malicious program is created
from scratch, so theoretically an antivirus tool
should have a reasonable chance of picking up new
variants. But the bad guys know this and buy the
major antivirus programs to test their variants before
release. Or, if they are on a budget, they run the
samples through sites like VirusTotal, which test
samples against dozens of antivirus tools.

The second major issue is that malware is a popular
market, with massive numbers of new variants
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appearing daily. Some antivirus vendors report on
the order of 65,000 new malware variations every
day! That is 65,000 signatures they need to create,
test, and release to their customers on a daily basis
(now you know why it’s important to update virus
definitions). Together these two factors make it
nearly impossible for antivirus vendors to keep up.
Their tools do filter a lot of malware, but never get
close to catching everything bad, and there is always
a window where new malware spreads before being
detected.

Far less malware exists for Macs, but even there we
see limited effectiveness across tools. For example,
in a recent test by Thomas Reed, even the best Mac
malware tool detected only 90 percent of the known
malware samples used. This is a poor showing — we
only see dozens of Mac malware variants per year,
compared to 65,000 per day for Windows.

Despite Flashback being used as a call to arms to
encourage people to adopt antivirus tools, most of
those tools failed to detect Flashback for weeks —
until it was highly publicized.

There are additional technical issues, as well. The
more analysis and detection you want, the deeper
antivirus tools need to hook into your system, and
the greater their potential for failure. Apple doesn’t
help much, being much more concerned with
preventing malware from taking over the operating
system than with helping antivirus vendors — who,
after all, need to monitor all access to files and
exercise control over launching applications and
opening files, which are just the kinds of things
malware authors want to do, too. There are also
major performance impacts, and nearly every
antivirus vendor has issued a bad signature at some
point, causing serious issues for customers —
typically false claims that a critical system or
application file is a virus, which of course causes
problems when the software attempts to prevent the
(critical, legitimate) file from “compromising” the
system.

Considering the current state of Mac security and the
malware environment today, I find it hard to
recommend Mac antivirus tools for most consumers.
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OS X’s built-in security and basic malware
protection currently stops most or even all existing
Mac malware, and new malware variants don’t
appear often enough for antivirus tools to provide a
significant benefit by protecting personal Macs. Mac
infections are so rare, and antivirus tools are so
limited, that they simply don’t offer enough value
for most Mac users — even the free ones.

When to Use Mac Antivirus -- Those limitations
aside, there are situations where antivirus software is
still useful.

The first, and best, is when you don t use it on the
desktop. Signature-based filtering in email stops
known viruses before they ever hit your desktop. I
highly recommend using an email service such as
Gmail, iCloud, Yahoo, or Hotmail that filters all
email for viruses before it is downloaded your
computer. For businesses | also recommend Web
filtering, but that isn’t easily available to regular
consumers.

The next group who might benefit from antivirus is
family members running older versions of OS X.
Nearly all the best anti-malware security features of
OS X are available with 10.8 Mountain Lion, with
10.7 Lion being second-best. We know TidBITS
readers largely stay up to date with Mac and 10S
operating system updates, but if family members
don’t, then antivirus may be warranted.

Corporate users may also need antivirus software to
comply with corporate policies or other
requirements.

If you consistently engage in high-risk behavior,
then antivirus software may be useful. For example,
if you turn off Gatekeeper and routinely download
illegal or dubious software, antivirus tools might
prevent infection. Maybe. Of course malware
appears on mainstream sites as well, but if you stick
with Gatekeeper and known developers your chance
of infection is almost nil.

Lastly, you might simply want antivirus for peace of
mind — understanding that antivirus tools are far
from infallible, and their users do still get infected,
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especially if you ignore the necessary patches and
definition updates.

If Mac antivirus tools offered 100 percent
effectiveness — or even 99 percent — I might take a
different position. If we ever see massive volumes of
malware, as happens in the Windows world, I might
change my recommendations. But at this point, there
are so few Mac malware infections, and antivirus
tools are so limited, that for most users of current
versions of OS X, antivirus doesn’t make sense.

During the Flashback infection there were
accusations that Mac users were too smug, or too ill-
informed, to install antivirus software. But the reality
is that antivirus tools offer only limited protection,
and relying on antivirus for your security is as naive
as believing Macs are invulnerable.

This article is copyright © 2013 Rich Mogull, TidBITS is

copyright © 2013 TidBITS Publishing Inc. Reuse governed by
Creative Commons License.

Managing Books in iTunes: This Novel Has a
Nice Beat
by Michael E. Cohen

A Take Control reader recently asked if we could
provide any tips for using iTunes on a Mac to
organize books in iBooks, since it is awkward to
organize them directly on an iOS device. The request
was forwarded to me, and, after some thought, |
came up with a few recommendations, though they
are, to my mind, clumsy and unsatisfying,
suggesting areas where Apple could improve the
experience.

Leveraging the Possible -- The biggest obstacle to
book-organizing paradise on an iOS device is that
the iBooks app provides few ways of arranging and
organizing books. Here’s what iBooks gives you:

» The familiar shelf view, which is the default. It
shows books by thumbnails of their covers,
arranged on a set of skeuomorphic bookshelves in
an infinitely tall bookcase. You can organize the
books on the shelves by dragging them around
manually, one at a time. Just as on an iOS home
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screen, you can’t leave empty spaces on a shelf:
they close up automatically, so you can’t dedicate
a particular shelf, or set of shelves, to a particular
set of books.

+ List view, which provides a scrolling list of the

books in a bookcase sorted in one of four ways:

o Bookshelf: This view lists books in the same
order as they appear on the bookcase.

o Titles: This view lists books alphabetically by
their titles.

o Authors: This list is sorted alphabetically by the
books’ authors.

o Categories: This displays the list alphabetically
by the books’ categories (more on that later),
with each category in the list headed by a
separator bar that displays the name of the
category.

[ p— Tech =
= Object-Oriented Programming with Objective-C
" The Objective-C Prog ing Languag
IPad User Guide

-

i
Eﬂ Take Control of Apple Mail in Lion (1.0)

Collections, which are separate bookcases to
which you can move one or more books, and to
which you can give names, such as Previously
Read or Short Story Collections.

When you edit a list view by tapping the Edit button
in iBooks, you can select books only for moving to
another collection or for deletion — except for the
Bookshelf list view, which provides drag handles for
books so you can drag a book up or down in the list
and so change the order shown in the shelf view.
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Books

Purchased Books

PDFs

Enhanced Rooks

That’s it: no other organizing and viewing tools are
offered. You can’t even edit titles, authors, or
categories in iBooks. For that, you need iTunes.

So here’s one useful book organizing thing you can
do in iTunes: normalize the books’ categories and
authors to get rid of variants, which will allow you to
better use the paltry few viewing and organizing
options that iBooks does provide. Here’s what [
mean:

1. In iTunes, show the books in List view. Using
View > View Options, display the Category
heading. This displays the genre associated with
each book, such as Fiction or Romance. (Genre?
Category? More below on this nomenclatural
inconsistency.)

(3] View Options

Sort by: | Author

ar

Books:
Album Release Date
@I Author @I Time
@] Category @ Year
™ Checked
¥ Personal
Album Rating Crouping
Comments @I Rating

Nacrrintinn

2. Sort the list by Category by clicking the Category
column heading.
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3. Scan the list and for each book that doesn’t have a
category, assign one: click once to select the book,
pause for a moment, then click near the left edge
of the Category column to get an insertion point
and start typing; iTunes auto-completes what you
type if it can. (Yes, this text-editing interface for
iTunes’ list views is worthy of a usability case
study in how best to baffle users.)

4.For books that have the “wrong” category (in your
opinion, which is the only one that matters, since
you are organizing your books for yourself), select
the book, pause briefly, click the displayed
category to make it editable, and type something
else.

5. Sort the list by author, and then edit the author
names so they are consistent; for example, “J.R.R.
Tolkien” is not, as far as iTunes and iBooks are
concerned, the same author as “J. R. R. Tolkien”
— spaces and punctuation matter.

6. For each author, select all the books, choose File >
Get Info, click the Sorting tab, and, in the Sort
Artist field, type how you want that author’s work
sorted; for example, you might specify “Tolkien,
J.R.R.” for books that have “J. R. R. Tolkien”
listed as author so his books sort among the Ts
instead of the Js in Authors list view — iBooks
respects the Sort Artist field in that view. (Artist?
Author? More about that nomenclatural
inconsistency below, too.)

Once you have the metadata (that is, data that
describes the data) for your books squared away in
iTunes, the list views available in iBooks become far
more useful. In addition, you can make use of the list
views in iBooks as an aid to organizing your books
into separate collections.

For example, you could create a new collection for
each author in iBooks, list the books in the default
Books collection by author, select the books by each
author, and then move them to the new collection
named for that author: voila, you now have an
iBooks library with a collection bookcase dedicated
to each of your authors.
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Similarly, you could create collections for each
category, and move books belonging to each
category to the appropriate collection (in this case, of
course, you may want to create more fine-grained
categories than, for example, Fiction and Nonfiction
for your books in iTunes — or maybe not, if that’s
how you roll).

(Note, by the way, that recent versions of iBooks can
sync your collections, and the books within them,
among multiple 10S devices: you can find that
option in Settings > iBooks on your i0S device.)

If you decide to parcel your books into separate
collections as I’ve just described, you have to do a
little housekeeping whenever you add books to your
library in iBooks: sync your iOS device with iTunes,
get the book metadata in order there, resync your
device, and, back in iBooks, move the books where
they belong.

Like I said, clumsy and not very satisfying.
Incredibly unsatisfying, in fact, for a librarian,
archivist, bibliographer, or bibliophile.

What iTunes Ignores -- As it happens, the EPUB
standard used by ebooks in iBooks (I am ignoring
for now the fact that iBooks also can handle PDFs
and iBooks Author books) has a robust specification
for including metadata in an ebook. This information
is usually found in the .opf file that each EPUB
includes, and it goes, not surprisingly, by the name
“metadata.” For example, here’s the metadata
included with one of my Take Control books:

<metadata xmlns:dc="http://purl.org/dc/
elements/1.1/" xmlns:opf="http://

www.idpf.org/2007/opf">

<dc:title>Take Control of TextExpander
(1.1)</dc:title>

<dc:creator opf:role="aut">Michael E.
Cohen</dc:creator>

<dc:contributor opf:role="bkp">Pages
v4.2</dc:contributor>

<dc:date>2012-07-26</dc:date>
<dc:subject>Reference</dc:subject>

<dc:identifier
id="BookId">2E23AA4C-86F2-40D4-863B-507386
2969C8</dc:identifier>
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<dc:language>en</dc:language>

<meta name="cover" content="cover-image"/
>

</metadata>

In it you can find the book’s title, author, subject,
and a bunch of other stuff: the metadata included in
an EPUB can be quite extensive. iTunes and iBooks,
in fact, are both capable of finding the .opf file
inside of an EPUB and reading the metadata from it.
In fact, that’s how iBooks and iTunes “know” the
title of a newly added book. However, unlike the
extensive use that iTunes makes of tags in your
music collection, neither iTunes nor iBooks makes
much use of book metadata.

In the case of a book that you add directly to iBooks,
iBooks extracts the title, the category (labeled in the
metadata as “subject”), and the author so it can sort
its list views appropriately.

iTunes also reads these particular metadata items,
and a couple more if they are present, and then
places a new file inside the EPUB named
1TunesMetadata.plist that contains the information
that iTunes has extracted. From then on, if you
change a book’s metadata in iTunes (for example,
the name of the author or the category of a book),
1Tunes modifies it in the iTunesMetadata.plist file
and leaves the .opf file intact.

One consequence of this approach is that other
ebook reading apps won’t see the metadata changes
you make to an EPUB in iTunes. Another, of interest
probably only to ebook publishers, is that when
iTunes adds the iTunesMetadata.plist file to an
EPUB, it doesn’t modify the “manifest” that’s also
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part of the .opf file to note the inclusion of the new
file, so any EPUB-validating software reports its
presence with a warning.

Also note that iTunes extracts only a few of the
EPUB’s metadata items. For instance, there is an
optional metadata item, “description,” often used by
publishers to provide a capsule summary of an
ebook, but iTunes ignores it. If you add a comment
about a book in iTunes (File > Get Info, and then put
something in the Comments field on the Info pane of
the Get Info window), iTunes puts it in the
1TunesMetadata.plist file, but it won’t pre-fill that
field with any description metadata that the book
already contains.

The Human Division #1: The B-Tea

Summary Video Sorting Options Artwork

Name

The Human Division #1: The B-Team

Artist Year
John Scalzi

Album Artist Track Number

The Human Division #1° The B-Team of

This comment will never leave iTunes, even if the book to which it applies

Science Fiction Part of a compilation

Previous Next Cancel oK

The Get Info window’s interface with which you can
modify the iTunesMetadata.plist file, in fact, is
strongly biased in favor of audio media — in
particular, individual songs. The Genre field is used
for songs; the iTunes Books library uses that field
for a book’s Category, but iTunes doesn’t bother to
relabel the field when you are editing a book’s
information. Similarly, songs are performed by
“artists,” and books are written by “authors,” but in
the iTunes Get Info window for an ebook, the author
name goes in the Artist field. (And don’t even get me
started on the inability of Get Info’s artwork pane to
show a book’s cover!)

Bake It Longer -- With the major overhaul that
Apple gave to the look and feel of iTunes in iTunes
11, Apple had a chance to revamp the Get Info
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interface to handle the different kinds of media that
1Tunes manages more fluidly and accurately. Instead,
Apple left Get Info virtually unchanged, so that you
have to guess that authors are really artists, that
categories are really genres, and that books don’t
have anything corresponding to Beats Per Minute
(yes, you can set that field in Get Info for a book,
though why you would want to do that — or why
iTunes even allows you to do it — beats me).

More sadly, Apple has done little in iBooks to
provide readers with the ability to see or to search
through their books by any metadata beyond titles,
categories, or authors, nor has Apple provided any
organizing tools in iBooks other than those I
described earlier. For the only ebook-reading
software that Apple provides on any of its platforms,
the lack of basic organizing tools in iBooks is
embarrassing.

Apple has said on more than one occasion that it
views its Apple TV product as a “hobby” — from
the short shrift that iTunes gives to book metadata
and the needs of book lovers to organize their
libraries, it seems that ebooks remain only a hobby
with Apple as well.

This article is copyright © 2013 Michael E. Cohen, TidBITS is

copyright © 2013 TidBITS Publishing Inc. Reuse governed by
Creative Commons License.

Selling a Mac: What Version of Mac OS X
Can You Include?

by Adam C. Engst

TidBITS reader Scott Maxwell asked for my advice
surrounding selling or giving away an old Mac, with
regard to the version of Mac OS X installed. In
Scott’s case, he wanted to give an old MacBook to a
relative. Scott didn’t remember what the MacBook
came with originally, but it’s currently running Mac
OS X 10.6 Snow Leopard and is compatible with
10.7 Lion, but not 10.8 Mountain Lion. Since Scott’s
relative wanted to be able to use iCloud, an upgrade
from Snow Leopard to Lion was necessary, but Lion
is no longer available in the Mac App Store.
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I’ll go through the legalities in a bit, but the simple
answer in this case is that you can still buy Lion
from Apple, but the process is a bit more involved.

How to Get OS X 10.7 Lion Installed -- First, you
must call Apple at 800-MY-APPLE (800-692-7753)
and work your way through the automated system
until you can talk to a representative. (After getting
frustrated with the first few directions, I pushed 0
and # a few times until the phonebot threw up its
hands and transferred me to a real person.) You can
then place an order for OS X 10.7 Lion for $19.99,
and within 3 business days, Apple will send you the
necessary Mac App Store redemption codes via
email. To download and install Lion, you must be
running 10.6.8, so if your Mac is running 10.5
Leopard or 10.4 Tiger, you may need to drop another

$19.99 on Snow Leopard, which Apple still sells on
DVD.

To save the time and expense of upgrading to Snow
Leopard just to get to Lion, you can try an
unsupported method of upgrading from Tiger or
Leopard to Lion explained in Joe Kissell’s “Take

Control of Upgrading to Lion.” Follow these steps:

1. Start your Mac normally from your old (Tiger or
Leopard) system.

2.Make sure you’re logged in as an administrator. (If
you’re not sure, open the Accounts pane of System
Preferences. If the account under which you’re
currently logged in has the word “Admin” under
it, you’re good to go.)

3.Open Terminal (in /Applications/Utilities) and
enter this, followed by pressing the Return key:
sudo nano /System/Library/CoreServices/
SystemVersion.plist

4. When prompted, enter your administrator
password.

5. Use the arrow keys to move the cursor down to the
last entry (the third-from-last line). Replace the
current version (for example, 10.4.11 or 10.5.8)
with 10.6.8.
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6. Press Control-X to quit the text editor, and press
Y when asked if you want to save the modified
buffer. Then you can quit Terminal.

Now you can boot from a volume containing Snow
Leopard or Lion and follow the normal steps for an
in-place upgrade; when the Lion installer prompts
for a destination, select the specially modified
volume.

(As an aside, if you have purchased Lion from the
Mac App Store and subsequently upgraded to
Mountain Lion, you can still download a copy of
Lion from your Purchases list. It shows up normally
for me, but if it’s hidden for you, choose Store >
View My Account, then click View Hidden
Purchases and the Unhide button. Once you have it,
you can use Recovery Disk Assistant to create an
external Recovery volume that you can boot from to
reinstall Lion.)

The Fine Print -- So why is all this necessary? Is
there really anything wrong with just wiping a Mac
you’re going to give away and installing a fresh copy
of the latest version of OS X it can run? I won’t tell
anyone if you do, but Apple’s legal beagles have
anticipated that you might want to do this and have
explicitly forbidden it in the Software License
Agreement.

To summarize, you can sell or give away a Mac with
the version of Mac OS X that came pre-installed on
it. If you bought 10.6 Snow Leopard on its own, you
can sell that on its own. But if you purchased your
license to Lion or Mountain Lion through the Mac
App Store, it is not transferable and must be
removed before you sell or give the Mac away. And
don’t think that getting Lion on a USB drive is a
workaround; Apple explicitly considers it equally as
non-transferable as a Mac App Store version.

Here’s the text for each of the last three versions of
Mac OS X:

10.6 Snow Leopard

3) Transfer. You may not rent, lease, lend, sell,
redistribute or sublicense the Apple Software.
Subject to the restrictions set forth below, you may,
however, make a one-time permanent transfer of all
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of your license rights to the Apple Software (in its
original form as provided by Apple) to another party,
provided that: (a) the transfer must include all of the
Apple Software, including all its component parts
(excluding Apple Boot ROM code and firmware),
original media, printed materials and this License;
(b) you do not retain any copies of the Apple
Software, full or partial, including copies stored on a
computer or other storage device; and (c) the party
receiving the Apple Software reads and agrees to
accept the terms and conditions of this License. You
may not rent, lease, lend, redistribute, sublicense or
transfer any Apple Software that has been modified
or replaced under Section 2H above. All components
of the Apple Software are provided as part of a
bundle and may not be separated from the bundle
and distributed as standalone applications. Apple
Software provided with a particular Apple-branded
hardware product may not run on other models of
Apple-branded hardware.

10.7 Lion
3) Transfer.

A. If you obtained the Apple Software preinstalled
on Apple-branded hardware, you may make a one-
time permanent transfer of all of your license rights
to the Apple Software (in its original form as
provided by Apple) to another party, provided that:
(1) the Apple Software is transferred together with
your Apple-branded hardware; (i) the transfer must
include all of the Apple Software, including all its
component parts, printed materials and this License;
(ii1) you do not retain any copies of the Apple
Software, full or partial, including copies stored on a
computer or other storage device; and (iv) the party
receiving the Apple Software reads and agrees to
accept the terms and conditions of this License. For
purposes of this License, if Apple provides an update
(e.g., version 10.7 to 10.7.1) to the Apple Software,
the update is considered part of the Apple Software
and may not be transferred separately from the pre-
update version of the Apple Software.

B. If you obtained your license to the Apple
Software from the Mac App Store or on Apple-
branded physical media, it is not transferable. If you
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sell your Apple-branded hardware to a third party,
you must remove the Apple Software from the
Apple-branded hardware before doing so, and you
may restore your system to the version of the Apple
operating system software that originally came with
your Apple hardware (the “Original Apple OS”) and
permanently transfer the Original Apple OS together
with your Apple hardware, provided that: (1) the
transfer must include all of the Original Apple OS,
including all its component parts, printed materials
and its license; (ii) you do not retain any copies of
the Original Apple OS, full or partial, including
copies stored on a computer or other storage device;
and (ii1) the party receiving the Original Apple OS
reads and agrees to accept the terms and conditions
of the Original Apple OS license.

10.8 Mountain Lion
3) Transfer.

A. If you obtained the Apple Software preinstalled
on Apple-branded hardware, you may make a one-
time permanent transfer of all of your license rights
to the Apple Software (in its original form as
provided by Apple) to another party, provided that:
(1) the Apple Software is transferred together with
your Apple-branded hardware; (i1) the transfer must
include all of the Apple Software, including all its
component parts, printed materials and this License;
(i11) you do not retain any copies of the Apple
Software, full or partial, including copies stored on a
computer or other storage device; and (iv) the party
receiving the Apple Software accepts the terms and
conditions of this License. For purposes of this
License, if Apple provides an update (e.g., version
10.8 to 10.8.1) to the Apple Software, the update is
considered part of the Apple Software and may not
be transferred separately from the pre-update version
of the Apple Software.

B. If you obtained your license to the Apple
Software from the Mac App Store, it is not
transferable. If you sell your Apple-branded
hardware to a third party, you must remove the
Apple Software from the Apple-branded hardware
before doing so, and you may restore your system to
the version of the Apple operating system software
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that originally came with your Apple hardware (the
“Original Apple OS”) and permanently transfer the
Original Apple OS together with your Apple
hardware, provided that: (i) the transfer must include
all of the Original Apple OS, including all its
component parts, printed materials and its license;
(i1) you do not retain any copies of the Original
Apple OS, full or partial, including copies stored on
a computer or other storage device; and (iii) the
party receiving the Original Apple OS reads and
agrees to accept the terms and conditions of the
Original Apple OS license.

This article is copyright © 2013 Adam C. Engst, TidBITS is

copyright © 2013 TidBITS Publishing Inc. Reuse governed by
Creative Commons License.

Apple User Group Bulletin * 15 January 2013
Submitted by Bruce Thompson

Recent Highlights from the Apple User Group
Resources website:

http://appleusergroupresources.com

AUG Special Offers for User Group Members:

* Special Offer — TinyLightbulbs Products: 20%
Off

* Special Offer — ReAuthored iPad “Book™ Cases:
20% Off

* Special Offer — Installer Maker: 33% Discount

» Special Offer — Atomic Training Video Tutorials:
20% Off

» Special Offer — TechTool Deluxe 3.1.4 update
now available free

» Special Offer — Mac|Life: Updated — Mac|Life:
Now 65% Off

» Special Offer — SlideShark iPad PowerPoint
Viewer: Free App plus

» Special Offer — AgileBits 1Password and more:
25% Discount

» Special Offer — O’Reilly: Wonderful Discounts
for User Group Members

» Special Offer — Eltima Software multimedia
products: Pay 20% less
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All offers and codes are on one easy-to-cut-and-
paste page for newsletter editors:

http://appleusergroupresources.com/special-offers-
with-codes/

Password from November 15, 2013 - May 15, 2013
ugcoolbuys

Hot Links:
Compiled by Tom Ostertag

Apple, Inc.
Is Apple Really Failing? | Cult of Mac

Apple celebrates nearly three decades of Macintosh |
Applelnsider

Mac Software

A Company Called 'Dropbox' Is Taking Over The
World | Business InSider

Adobe releases Creative Suite 2 for free | MacFixit

OS X Mountain Lion overtakes OS X Lion in web
traffic | Edible Apple

Find Duplicate Contacts Merge Them On Your Mac

1o Simplify Your Digital Life | Cult of Mac

Office for iOS may be coming, but does it really
matter? | MacWorld

Mac Hardware

A Trip Down Memory Lane: The Apple Lisa And
Apple Ile Turn 30 | Infinite Loop

This Old G4 IMac Can Now Run Mountain Lion
Thanks To Its New Ivy Bridge Processor | Cult Of
Mac
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Apple Wins Patent For Glass-On-Metal Trackpads |
Cult Of Mac

Help Your Older Mac Feel Snappier — Disable
Finder Media Previews | Cult Of Mac

Apple's 2013 Product Pipeline To Feature New
IPhones And All-Retina [Pad And MacBook Pro
Lineups | Applelnsider

iI0S/iPad/iPod/iPhone/iTunes/iCloud

Must-Have iOS Apps: Documents, Finish, Poster &
More | Cult of Mac

Amazon'’s MP3 store “specifically for iPhone and
iPod touch’ | Infinite Loop

Opera Takes On Mobile Web Browsing With Ice For
Android And iOS | Cult of Mac

Get Your Archived Mail Back To The Inbox On Your
iPhone | Cult of Mac

Readdle Launches Documents, A Free File Manager
& Media Player For iPad | Cult of Mac

Miscellaneous

How To: Disable Dashboard in OS X Mountain Lion
| FairerPlatform

This Old G4 iMac Can Now Run Mountain Lion
Thanks To Its New Ivy Bridge Processor | Cult of
Mac

Well, the world didn 't end. Time to set financial

goals for 2013! | Splasmata

How To Hide iOS Apps Inside The Newsstand Folder
Without Jailbreaking | Cult of Mac

Canon s Instagrammatical Camera Plays Nice With
Your iPhone | Cult of Mac
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Members Helping Members

Need Help? Have a question the manual doesn’t
answer? Members Helping Members is a group of
volunteers who have generously agreed to help.
They are just a phone call or an email away. Please

call only during the appropriate times, and only if
you are a current mini’app’les member and own
the software in question.

Apple 11/ IIGS Software & Hardware................... NV MaC OS X oottt NV
AppleWorks / ClarisWorks...........ccoeeeerieeieennennne. 3,4 Microsoft EXCel......oooieriiiiiiiiieieeiieeceee 5
ClasSiC MACS .....ccooovviiiiiiiiiiiiiiieeeeeeeeee NV Microsoft WOrd......ccoooveeeeeeiiiiiiiiiiiieeeeeeeeeeeeeeeeeee 2,5
Cross-Platform File Transfer.........ccccccovvvvuvvvnnnnnn. 2,3 NEIWOTKS...evvviiiieieiieeeieeeee e NV
FileMaker Pro.......cccccooeiiiiiiiiiiicceeeeeee e NV NEW USECIS ..uviiiiiciiiiececiee et 1
TIMACS ettt NV PhotoShop ....oovvieiiiiiee e, NV
Intel-Based Macs .........cccoeveeeiiiiieieiieeeeciee e NV QUArKXPIESS.....oeiieeiiiie e 5
TPROTO. ..o 2,3 QUICKEN ...t NV
IMOVIC...iiiiiiiiiiee et e e NV QuickBooks and QuickBooks Pro........................ NV
TWOTK oo 4 VeCtorWOTKS ....cvvveeiiieciiiecieeeee e NV
MaC OS ClaSSIC ..veeeeuiiiiieeiiiee et 3

1. Les Anderson 651-735-3953  anderslc(@usfamily.net DEW

2. Tom Ostertag 651-488-9979  tosterta .com DEW

3. Bruce Thompson 763-546-1088 bthompson@macconnect.com  EW

4. Pam Lienke 651-343-5475 plienke@aol.com DEW

5. Ron Heck 651-774-9151 ronheck@comcast.net DEW

D = Days, generally 9 a.m. to 5 p.m.

E = Evenings, generally 5 p.m. to 9 p.m.
W= Weekends, generally 1 p.m. to 9 p.m.
NV = No Volunteer

Please call at reasonable hours and ask if it is a convenient time for helping you. By the way, many of these
volunteers can also be contacted on our forums. We appreciate your cooperation.

Mini’app’les needs more volunteers for Members Helping Members — If you are willing to
be a Members Helping Members volunteer, please send an email message to Membership Director
Mike Bertrand or contact him on our forums with your name, telephone number, contact hours, and the
software and hardware areas you are willing to support.
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Mini’app’les Membership Application and Renewal Form
Membership cost is $15.00 for one year. To pay electronically using PayPal, visit the mini’app’les website.
If you prefer to pay by check, use the form below. Please make your check payable to “mini’app’les.”

Name:

Company (if mailed to):
Address:

City, State, Zip:

Phone # (home):
Phone # (work):
Phone # (cell):
Membership ID # (if renewal):

Email;

Your email address will NOT be sold, shared, or distributed. It will be used only for official mini’app les business such as distribution
of the newsletter and membership renewal reminders.

Check if this is a change of address notice
Check if you want to volunteer
Check if you want to be added to “Members Helping Members”

Check if you were referred by a club member (if so, please give member’s name)

Please mail this application and your payment to:
mini’app’les
P.O. Box 796
Hopkins, MN 55343-0796

Thank you for your support!

Benefits of mini’app’les Membership

« Access to the mini’app’les online forums. Post questions and/or answers about issues, trouble shooting,
products, buying and selling, special events, discounts, and news about Apple and the mini’app’les club.

« Access to our Members Helping Members network of professional and advanced users of Apple technologies.
These members volunteer their time to help other members with software, hardware, and other Apple related
issues.

« A variety of Mac Special Interest Groups (SIGs) that meet each month.

« Multi-SIG meetings and workshops to help members with computer problems. You can bring your equipment
to these events and receive support from knowledgeable Mac users to help diagnose your problem(s).

« Participation in drawings for computer hardware, software, and other computer related materials.

» Discounts from vendors and manufacturers. Refer to the on-line forums for current offers.
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min1’app’les

the minnesota apple computer users’ group, inc.

Introduction — This is the newsletter of mini’app’les, the Board of Directors

Minnesota Apple Computer Users’ Group, Inc., a Minnesota

non-profit club. The whole newsletter is copyrighted © by President Tim Drenk

mini’app’les. Articles may be reproduced in other non-profit 952-479-0891

User Groups’ publications except where specifically copyrighted . .

by the author (permission to reproduce these articles must be timdrenk(@miniapples.org
given by the author). Please include the source when reprinting. Vice President Jeff Berg

The mini’app’les Newsletter is an independent publication not 781-350-0598
affiliated, sponsored, or sanctiope.d by Apple, Inc. or any other e fii@purpleshark com
computer manufacturer. The opinions, statements, positions, and

views are those of the author(s) or newsletter staff and are not Secretary Joel Gerdeen

intended to represent the opinions, statements, positions, or

views of Apple, Inc., or any other computer manufacturer. 763-607-0906

Instead of placing a trademark symbol at every occurrence of a jgerdeen(@mac.com
trade-marked name, we state we are using the names only in an

editorial manner, to the benefit of the trademark owner, with no Treasurer Bob Demeules
intention of infringement of the trademark. 763-559-1124
Questions — Members with technical questions should refer to osX.sig@mac.com

the Members Helping Members section or bring their questions . . .
to an appropriate SIG meeting. Please direct other questions to Membership Director Mike Bertrand
an appropriate board member. 651-772-3427

tubguy(@mac.com

Dealers — Mini’app’les does not endorse specific dealers. The
club promotes distribution of information that may help Publications Director Tom Ostertag
members identify best buys and service. The club itself does not
participate in bulk purchases of media, software, hardware, and 651-488-9979
publications. Members may organize such activities on behalf of tosterta .com
other members.

SIG Director Kevin Strysik
Submissions — We welcome contributions from our members. 651-489-4691
Perhaps you’re using new software that you just can’t live
without. Maybe you have a new piece of hardware that you find
extremely useful and of high quality. On the other hand, you

strysik(@mac.com

might be struggling with problematic software or hardware. Director at Large Bruce Thompson
Why not share your experience with other members by writing a 763-546-1088
product review? Doing so may steer others towards quality bthompson@macconnect.com

products or help them avoid the problems you may be having.

Submissions must be received by the 15th day of each month to
be included in the next month’s newsletter. Please send
contributions directly to our post office box (mini’app’les, PO
Box 796, Hopkins MN 55343), or email them to
info@miniapples.org.

The deadline for material for the next newsletter is the fifteenth
of the month. An article will be printed when space permits and,
if in the opinion of the Newsletter Editor or Publications
Director, it constitutes material suitable for publication.

This newsletter was produced using Apple’s Pages word
processor.
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